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Visual License Agreement 
 
 
CAREFULLY READ ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT BEFORE 
USING THIS COMPUTER SOFTWARE (THE “PROGRAMS”) AND ACCOMPANYING 
DOCUMENTATION (THE ”DOCUMENTATION”).  YOUR USE OF THE PROGRAMS IS 
SUBJECT TO THE TERMS OF THIS AGREEMENT.  IF YOU DO NOT AGREE WITH THESE 
TERMS, YOU SHOULD REMOVE THE PROGRAMS FROM YOUR COMPUTER AND NOT 
USE THE PROGRAMS.  IF YOU RECEIVED THE PROGRAMS ON CD-ROM PROMPTLY 
RETURN THE CD-ROM (TOGETHER WITH PROOF OF PAYMENT, IF ANY) TO ACUITY 
LIGHTING GROUP, INC. FOR A REFUND OF ANY AMOUNTS YOU HAVE PAID.  ONCE YOU 
HAVE USED THE PROGRAMS, YOU WILL BE DEEMED TO HAVE ACCEPTED THE TERMS 
OF THIS LICENSE AGREEMENT. 
 
1.0 Ownership  
 
The Programs are proprietary products of Acuity Lighting Group, Inc. and its licensors, and are 
protected under applicable copyright and/or trade secret laws.  All right, title and interest in and to 
the Programs shall remain with Acuity Lighting Group, Inc. and its licensors.  This Agreement 
does not constitute a sale of the Programs, but only conveys to you a limited right to use the 
Programs in accordance with the terms of this Agreement.  Acuity Lighting Group, Inc. and its 
licensors retain all rights in the Programs not expressly granted. 
 
 
2.0 License Termination 
 
You are granted a limited, revocable, nonexclusive, nontransferable license to use the Programs 
on a single computer in accordance with the Documentation. All proprietary notices in or on a 
Program shall be duplicated by you on all copies of the Program and shall not be altered or 
removed.  Except as expressly permitted herein, you may not alter, modify, copy, disassemble, 
decompile, reverse engineer, create derivative works from, or sell, sublicense, rent, or otherwise 
transfer to any other person or entity, the Programs or the Documentation.  Your right to use the 
Programs shall terminate upon your failure to comply with any term or condition of this 
Agreement.  Upon termination of the licenses granted herein, you must cease all use of the 
Programs and destroy the Programs (including all copies thereof) and all Documentation, and 
certify to Acuity Lighting Group that all Programs and Documentation have been so destroyed.  
All other rights and obligations set forth herein shall survive termination of the licenses granted 
herein. 
 
3.0 Limited Warranty and Disclaimer 
 
THE SOFTWARE LICENSED HEREIN IS LICENSED “AS IS” AND LITHONIA MAKES NO 
REPRESENTATIONS OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, WHICH 
MIGHT OTHERWISE APPLY TO THE PROGRAMS OR DOCUMENTATION.  ALL 
WARRANTIES AND CONDITIONS, INCLUDING, WITHOUT LIMITATION, IMPLIED 
WARRANTIES OF NONINFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE AND THOSE ARISING BY STATUTE OR OTHERWISE IN LAW OR 
FROM COURSE OF DEALING OR USAGE OF TRADE ARE HEREBY EXPRESSLY 
DISCLAIMED.  Some states or jurisdictions do not allow the exclusion of the implied warranties, 
so the above exclusion may not apply to you.  This warranty gives you specific legal rights, and 
you may also have other rights that vary from state to state.    Acuity Lighting Group, Inc.  does 
not warrant that the operation of the Programs will be uninterrupted or error-free, or that they will 
meet your requirements. 



Visual User’s Guide  6 
 

4.0 Limitations   
 
As the user of the Programs, you are solely responsible for the selection of the Programs to 
achieve their intended results, for the installation and use made of the Programs, and for the 
results obtained from the Programs.  The Programs are intended to assist with lighting design 
and are not a substitute for independent lighting analysis and testing for lighting safety and 
suitability.  IN NO EVENT SHALL ACUITY LIGHTING GROUP, INC. OR ITS LICENSORS BE 
LIABLE WHETHER IN CONTRACT OR IN TORT, FOR ANY LOSSES OR DAMAGES 
WHATSOEVER, (INCLUDING WITHOUT LIMITATION, ANY DIRECT, INDIRECT, 
CONSEQUENTIAL, SPECIAL OR INCIDENTAL DAMAGES WHATSOEVER (INCLUDING 
WITHOUT LIMITATION, DAMAGES RESULTING FROM DIFFERENCES BETWEEN 
MEASURED LIGHTING SYSTEM PERFORMANCE AND LIGHTING SYSTEM PERFORMANCE 
PREDICTED BY USING THE PROGRAMS, OR DAMAGES FOR LOSS OF BUSINESS PROFIT, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHER PECUNIARY 
LOSS) ARISING OUT OF OR RELATING TO THIS AGREEMENT OR YOUR USE OF OR 
INABILITY TO USE THE PROGRAMS, EVEN IF ACUITY LIGHTING GROUP, INC. HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  IN NO EVENT WILL THE TOTAL 
LIABILITY OF THE ACUITY LIGHTING GROUP TO YOU OR ANY OTHER PARTY FOR ANY 
LOSSES OR DAMAGES RESULTING FROM ANY CLAIMS, DEMANDS OR ACTIONS ARISING 
OUT OF OR RELATING TO THIS AGREEMENT OR YOUR USE OF THE PROGRAMS OR 
DOCUMENTATION EXCEED THE LICENSE FEES PAID FOR USE OF THE PROGRAMS OR 
$100, WHICHEVER IS GREATER.  Some states or jurisdictions do not allow the exclusion or 
limitation of certain damages.  The limitations provided in this License Agreement are intended to 
apply to the fullest extent allowable under applicable law. 
 
5.0 Export   
 
You acknowledge that the Programs are subject to restrictions and controls imposed by the 
United States Export Administration Act (the “Act”) and the regulations thereunder.  You agree 
and certify that neither the Programs nor any direct product thereof is being or will be acquired, 
shipped, transferred or re-exported, directly or indirectly, into any country prohibited by the Act 
and the regulations thereunder or will be used for any purposes prohibited by the same.   
 
6.0 Government Users 
 
The Programs are provided with RESTRICTED RIGHTS.  Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013, and in subparagraphs 
(a) through (d) of the Commercial Computer-Restricted Rights clause at FAR 52.227-19, and in 
similar clauses in the NASA FAR Supplement, when applicable. 
 
7.0 Miscellaneous 
 
This Agreement shall be construed in accordance with the laws of the State of Georgia.  You 
agree that the exclusive jurisdiction for any claim or action arising out of or relating to this License 
Agreement shall be filed only in the state or federal courts located in the state of Georgia, and 
you further agree and submit to the exercise of personal jurisdiction of such courts for the 
purpose of litigating any such claim or action. This Agreement may not be altered or amended 
except by a written document signed by an authorized officer of Acuity Lighting Group, Inc.  You 
may not assign this Agreement or any rights or obligations hereunder to any other person or 
entity without the prior consent of Acuity Lighting Group, Inc.. 
 
Should you have any questions concerning this Agreement or the Programs, or the 
Documentation, please contact Acuity Lighting Group, Inc. by calling (800) 279-8043. 
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System Requirements 
 
Visual has been programmed for a Microsoft Windows 95/98/ME/XP/2000/NT 4.0 environment.  
The minimum system requirements to successfully run the application are listed below: 
 
• Microsoft Windows 95/98/ME/NT/2000/XP 
• Pentium Processor, 200 MHz minimum 
• 25-105 MB Hard Drive space for install depending on installation component choices 
• 64 MB RAM minimum, 128 MB RAM or more recommended 
• 800x600xSmall Fonts minimum screen resolution, 1024x768xSmall Fonts recommended 
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Installation, Registration and Technical Support 
 

Installation 
 

1. Download the setup program from http://www.VisualLightingSoftware.com. Make sure to save 
the setup program to your hard drive.  Run the setup by double-clicking the setup file. 
    -or-  
Insert the Visual CD into your CD-ROM Drive. The Visual CD Browser will appear. Select 
INSTALL VISUAL. 
 

2. The Visual Installation program will begin running.  Follow the instructions that appear on 
your screen. 
 

3. Visit http://www.VisualLightingSoftware.com to check for program news and updates. 

Registration 
 

It is important that we keep all users informed of updates for Visual.  To register as a Visual 
user, please create an account on the Visual website: http://www.VisualLightingSoftware.com

 

Technical Support 
 

For technical support questions, please visit the Support section of the Visual website or 
contact the Visual Support Center via email or telephone: 
 
• Internet: http://www.VisualLightingSoftware.com 
• Email:  support@VisualLightingSoftware.com  
• Phone:  1-800-279-8043, Monday – Friday 8 AM – 5 PM EST 
 

http://www.visuallightingsoftware.com/
http://www.visuallightingsoftware.com/
http://www.visuallightingsoftware.com/
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Document Conventions 
 
Numerous instructions and references appear throughout this guide.  The following conventions 
are designed to make it quick and easy to find and understand information. 
 
• Menu names and items are printed in small caps type.  For Example:  “Select ARC from the 

CONSTRUCT MENU.” 
 
• Form and Dialog Box names as well as major interface elements are printed in bold type.  

For Example:  The Options Form will appear.” 
 
• Terms that are defined in the glossary appear in Italics.  For Example:  “Visual will calculate 

the illuminance level.” 
 
• References to keyboard keys appear in 8 point all caps type.  For example:  “Press the TAB 

key on the keyboard to change the working plane.” 
 
• Input that must be typed into a text or list box in this guide is printed in bold type.  For 

example:  “Enter 2.5 into the Workplane Height Text Box.” 
 
• Filenames that are referred to are in 10 point all caps type.  For example:  “Save the file as 

FOOTBALLFIELD.VSL.” 
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Scope, Features and Limitations 
 

Scope 
 
The Visual Roadway Lighting Tool is designed to speed the process of designing roadway 
lighting systems based on IESNA RP-8 or CIE 2000 standards.  The Roadway Lighting Tool 
provides a step-by-step interface for calculating luminaire spacing, luminance, illuminance, veiling 
luminance, small target visibility, longitudinal uniformity and threshold increment.  Roadway 
designs can be imported into the Visual Professional Edition for additional design and analysis 
capabilities. 
 

Features 
 
• Run as a standalone program or from within the Visual Professional Edition. 
• Design using either the IESNA RP-8 or CIE-2000 calculation method. 
• Independently define the number and width of the left and right lanes, and optionally specify 

a median. 
• Create and use multiple luminaires. Luminaires can be independently placed on the left, 

median and right sides of the roadway. 
• Calculate using built-in IESNA and CIE recommendations, or specify individual criteria. 
• Real-time calculations provide instantaneous feedback throughout the design process. 
• Graph system performance versus luminaire cycle spacing. 
• Design and compare multiple roadway designs. 
• Print formatted professional output. 
 

Limitations 
 
• Restricted to uniform straight sections of roadway. 
• Calculates only one side of the roadway at a time (per RP-8 and CIE 2000). 
• Does not perform calculations for sidewalks. 
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Chapter 1 - Understanding The Interface 
 
The Visual Roadway Lighting Tool is presented in enhanced wizard format. The interface 
includes a standard wizard-style navigation bar as well as a menu bar and a toolbar that provide 
additional functionality. 
 

 
 
The Menu Bar 
 
The menu bar provides access to the extended functionality of the design tool. Functions such as 
file management, changing tool settings and obtaining Help are accessed through the menu bar. 
 
The Toolbar 
 
The toolbar provides quick access to commonly used commands. It also provides a dropdown list 
for switching between multiple designs. 
 
The Navigation Bar 
 
The Navigation Bar provides wizard style navigation using the familiar Back, Next, Cancel and 
Finish buttons.  The Navigation Bar also includes buttons for each step to facilitate design 
modification. 
 
*Note: The Cancel and Finish buttons are not available when the Roadway Lighting Tool is run as 
a standalone program.   
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Chapter 2 - Using the Roadway Lighting Tool 
 

2.1  The Steps View 
 
The Steps view is where roadway lighting designs are created. Each step will display a section 
for data input, a roadway graphic and the calculated results. 
 

  
 
Input Section 
 
Each step in the Roadway Lighting Tool includes a section for data input on the left side of the 
screen. Data input is provided via textbox, option selection, checkbox selection or a drop-down 
list. Certain fields may restrict input data to appropriate values. For example, the number of lanes 
for a roadway can only be a positive whole number such as 2 -- a fractional number such as 2.5 
is not permitted. 
 
Roadway Image 
 
The roadway graphic located in the center of the screen provides a visual representation of the 
roadway geometry, luminaire locations and calculation values. The roadway image is 
automatically updated each time a design parameter is changed. 
 
Results Display 
 
The results section is located on the right side of each step. This section provides immediate 
numerical feedback as well as controlling some display and calculation options. The results 
section is automatically updated each time a design parameter is changed. 
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2.1.1  Step 1 – Roadway Information 
 
Step 1 consists of the definition of the roadway and selection of a calculation method (IESNA 
RP8 or CIE) and classification.  Proper roadway classification is necessary for obtaining the 
correct IESNA or CIE design recommendations in Step 4. Each input field is described below. 
 

 

Roadway 
 
The Roadway section controls the physical geometry of the roadway. 
 
Number of Lanes 
 
The number of lanes can be independently defined for the left and right side of the roadway. To 
design a one-way roadway with traffic moving in the same direction, enter 0 for the number of 
right lanes, as shown in the graphic above. 
 
Lane Width 
 
The lane width can be independently defined for the left and right side of the roadway. The lane 
width applies to each lane on the associated side of the roadway. 
 
Median Width 
 
A median width greater than 0 designates a divided roadway. To design a two-way roadway with 
no median, enter a median width of 0. 



Visual User’s Guide  14 
 

Classification 
 
The Classification section controls the design method to be used and any parameters required by 
the selected method 
 
Method 
 
Roadway designs can be created using either the IESNA RP8-2000 or CIE 2000 methods.  
Selection of a calculation method will change associated options throughout the tool.  
 
Pavement  
 
Pavement reflectances based on IESNA RP8-2000 and CIE 2000 are provided for concrete and 
asphalt roadways. Both use a similar R1 to R4 classification. A complete description of pavement 
reflectance is in the Glossary. 
 
Road 
 
The IESNA RP8-2000 roadway classifications are based on roadway traffic volume, location, and 
intended usage.  The CIE 2000 roadway classifications are similar to the IESNA classifications 
but also include pedestrian activity. A complete description of roadway classification is in the 
Glossary. 
 
Pedestrians 
 
Pedestrian Conflict classifications are defined by the IESNA only, and are used to describe 
nightly pedestrian activity. A complete description of pedestrian conflict is in the Glossary. 
 

Units 
 
The choice of units applies to all physical dimensions. The units of illuminance are specified in 
Step 4. 
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2.1.2  Step 2 – Luminaire Schedule 
 
Step 2 consists of defining the luminaires that will be used in the roadway design. If the Roadway 
Lighting Tool is being run from within the Visual Professional Edition, any luminaires that are in 
the Professional Edition’s luminaire schedule will be imported into the Roadway Lighting Tool. 
 

 

Luminaire 
 
The Luminaire section provides functionality for managing the luminaire schedule. 
 
New 
 

 
 
Click the New button to create a new luminaire and begin the process of defining the luminaire 
properties. The luminaire label will automatically default to the next available character in the 
alphabet.  
 
Copy 
 

 
 
Select Copy to create a copy of the current luminaire. The luminaire label will automatically 
default to the next available character in the alphabet.  
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Delete 
 

 
 
Select Delete to remove the current luminaire from the schedule. 
 
Label 
 
The label field has a dual function.  Selecting a luminaire from the drop-down list makes it the 
current luminaire and loads its properties for editing.  Typing into the field modifies the label of the 
current luminaire. 

Properties 
 
The Properties section allows for modification of the currently selected luminaire (as shown in the 
Label field in the Luminaire section). 
   
Photometric File 
 

 
 
Click the file folder button to the right of the Photometric File field to display the Luminaire 
Selection dialog. See section 2.5 Selecting a Photometric File for more information.  After file has 
been selected, the remaining fields will be filled with the new information. 
 
Catalog Number 
 
The Catalog Number will default to the information provided in the selected luminaire file. For an 
IESNA formatted luminaire file, this information is retrieved from the line with keyword [LUMCAT]. 
 
Lumens Per Lamp 
 
The Lumens Per Lamp will default to the rated lamp lumens from the selected luminaire file. 
Changing the value in this field will re-rate the luminaire and affect the calculations. 
 
Input Power 
 
The Input Power will default to the information provided in the selected luminaire file. This field is 
for reporting purposes only and has no effect on the calculations. 
 
Light Loss Factor 
 
The Light Loss Factor field defaults to a value of 1.0. This will result in calculation values based 
on initial lumen values.  To calculate maintained values, an appropriate light loss factor must be 
entered here. 
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Configuration 
 

 
 
The luminaire configuration defaults to single luminaire on a pole. Other options include a post-
top, a twin configuration, a bull-horn configuration and a custom configuration.  Additionally, 
complex luminaire configurations can be created in the Visual Professional Edition and imported 
into the Roadway Lighting Tool. 
 
The bull-horn configuration consists of two luminaires on a pole with each luminaire oriented in 
the same direction.  
 
The custom configuration is typically used for high-mast luminaires. The specified number of 
fixtures will be arranged circularly around the pole. 
 
Tilt 
 
The Tilt field specifies the vertical tilt of each individual luminaire in the current configuration. Tilt 
is measured from horizontal with positive tilt “upward”. 
 
Arm Length 
 
The Arm Length field specifies the length of the luminaire support arm(s).  It defaults to 0.75 feet 
(9 inches) for the single and twin configurations. A single post-top configuration defaults to zero 
arm length. The bull-horn and custom configurations default to an arm length of 1.5 feet. 
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2.1.3  Step 3 – Luminaire Locations 
 
Step 3 consists of placing luminaires in the desired locations.  The Roadway Lighting Tool allows 
a different luminaire type to be place in each location. 
 

 
 

Position Tabs 
 

 
 
The position tabs at the bottom of the screen provide access to the five locations supported by 
the Roadway Lighting Tool.  The Side tab allows luminaires to be placed on the left and right 
shoulders of the road.  The Median tab allows luminaire placement in the middle of the median 
(no setback).  The Median L/R tab allows luminaires to be placed on the left and/or right side of 
the median. 

Location Sections 
 
Each location section provides fields for specifying and positioning luminaires. 
 
Luminaire 
 
Select a luminaire from the drop-down list to place it in the corresponding location. 
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Mounting Height 
 
The mounting height specifies the vertical distance from the roadway surface to the center of the 
luminous area of the luminaire. The luminous area is typically the bottom of the luminaire 
housing. Note that this is not always equivalent to the pole height. 
 
Orientation 
 
The orientation specifies the orientation of luminaire configuration with respect to the road. An 
orientation of 0 degrees corresponds to North (up on the screen), 90 degrees to East, 180 to 
South and 270 degree to West. 
 
Setback 
 
The setback defines the distance from the edge of the roadway to the pole location of a luminaire 
configuration.  
 
Note: Luminaires placed in the Median location are always centered in the median and thus have 
no Setback field. The Median Left and Right locations may be used if a specific setback is 
desired. 
 
Staggered 
 
The staggered checkbox causes the luminaires in the associated location to be offset by half a 
cycle spacing.  
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2.1.4  Step 4 – Design Criteria 
 
Step 4 consists of specifying criteria for design optimization. The Roadway Lighting Tool will 
determine the greatest spacing that satisfies all of the specified criteria.  In cases where it is not 
possible to meet all of the specified criteria, a message will be displayed indicating which criteria 
could not be met. 
 

 

Design Criteria 
 
The Design Criteria section provides fields for specifying the design goals for the lighting system. 
 
IES/CIE Recommendations 
 
Selecting an IES or CIE Recommendation will enter the appropriate lighting recommendations 
into the design criteria fields.  The recommendations are based on the information specified in 
the Classification section of Step 1.  
 
IESNA RP8-2000 provides recommendations for luminance and illuminance, while CIE 2000 
provides recommendations only for luminance. 
 
Note: Changing the Classifications in Step 1 will not update the design criteria. The IES 
Recommendations must be reselected to update the values. 
 
Luminance 
 
A design based on luminance criteria is recommended for roadways with a majority of vehicle 
traffic such as a freeway, expressway, or major roadway.  
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Illuminance 
 
A design based on illuminance criteria is recommend for the analysis of areas with high levels of 
pedestrian traffic, intersections and high mast lighting. 
 
Veiling Luminance [ Lv ] – IESNA RP8 Only 
 
The Veiling Luminance Ratio design criterion will only appear when the IESNA RP8-200 
calculation method is selected in Step 1. See the Glossary for an explanation of Veiling 
Luminance Ratio. 
 
Threshold Increment [ Ti ] – CIE 2000 Only 
 
The Threshold Increment design criterion will only appear when the CIE calculation method is 
selected in Step 1. See the Glossary for an explanation of Threshold Increment. 
 
Luminaire Spacing 
 
A roadway design at a particular spacing can be quickly analyzed by entering a value in this field. 
All other design criteria will be ignored when the luminaire spacing has been specified. 
 
Roadway Length 
 
The roadway length can be specified to determine the total number of luminaires required for the 
design. Specifying a roadway length has no effect on the calculations. 

Illuminance Units 
 
The choice of units applies to illuminance only. Luminance is always reported in cd/m². 
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2.1.5 The Results Display  
 
The Results display, located on the right side of each step of the Roadway Lighting Tool, 
provides immediate evaluation of design modifications on any step in the tool. 
 
Target criteria values appear in brackets to the right of certain metrics. Each criterion that is 
specified in Step 4 will appear in black.  Each calculated result is compared to its target value (if 
any) and is displayed in red if it does not satisfy the criterion.  If no target value is specified, but 
an IESNA or CIE recommendation exists for a particular criterion, the recommended value will 
appear in gray. The gray recommended values are for informational purposes only -- no 
comparison is performed. 
 

  

Results 
 
The Results section reports the lighting system performance. The particular statistics that are 
displayed in the Results section can be chosen in the Options dialog. Certain items have a round 
option control to their immediate left.  Clicking the option control displays the corresponding 
calculation grid in the roadway graphic. 
 
Luminance 
 
The luminance lighting metrics provide an analysis of the light reflected off of the pavement in the 
direction of the driver. The luminance lighting metrics indicate how bright the roadway surface 
appears. Maximum to Minimum and Average to Minimum luminance ratios are used when the 
IESNA calculation method is selected in Step 1, while Minimum to Maximum and Minimum to 
Average luminance ratios are used when the CIE calculation method is selected. 
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Illuminance 
 
The illuminance lighting metrics provide an analysis of the amount of light incident on the 
roadway surface due to the lighting design. Maximum to Minimum and Average to Minimum 
illuminance ratios are used when the IESNA calculation method is selected in Step 1, while 
Minimum to Maximum and Minimum to Average illuminance ratios are used when the CIE 
calculation method is selected. 
 
Veiling Luminance Ratio [ Lv Ratio ] – IESNA RP8 Only 
 
The veiling luminance ratio provides an evaluation of the disability glare from a roadway lighting 
design. This metric will only appear in the Results section when the IESNA calculation method is 
selected in Step 1. 
 
Small Target Visibility [ STV ] – IESNA RP8 Only 
 
Small target visibility provides an evaluation of the visibility of an array of targets on the roadway. 
STV will only appear in the Results section when the IESNA calculation method is selected in 
Step 1. 
 
Threshold Increment [ Ti ] – CIE 2000 Only 
 
Threshold increment is a measure of the loss of visibility due to disability glare from the 
luminaires of the roadway design.  This metric will only appear in the Results section when the 
CIE calculation method is selected in Step 1. 
 
Longitudinal Uniformity [ Ul ] – CIE 2000 Only 
 
Longitudinal uniformity is the calculated ratio of the lowest luminance to the highest luminance 
along a line parallel to the length of the roadway. Longitudinal uniformity will only appear in the 
Results section when the CIE calculation method is selected in Step 1. 
 
Spacing 
 
The spacing is the typical spacing for one luminaire cycle. It applies to all luminaire locations (left, 
right, median, etc...). 
 
Quantity 
 
This result only appears if a value is entered for the Roadway Length in Step 4. This number is 
the total quantity of luminaires at all locations required for the specified roadway length.  
  
*Note: The number of luminaires required per the left side, right side and median locations 
appears on the summary page of the printed documentation. 

Display 
 
The Display section controls the display of point values and iso-contour lines in the roadway 
graphic. 
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Grid Location 
 
The Grid Location section specifies on which side of the roadway the calculations are to be 
performed. As most roadway metrics are sensitive to the position of the observer, the grid 
location can be an important factor. 
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2.2 The Graph View 
 
The graph view displays lighting system performance as a function of spacing. The screen 
consists of a section specifying the graph parameters on the right with the graph itself occupying 
the remainder of the screen. 
 

 
 

Spacing 
 
The Spacing section controls the horizontal axis.  The lighting system will be evaluated at each 
spacing value on the horizontal axis.  A total of 15 spacing values will be evaluated. 
 
Start 
 
This field specifies the initial system spacing to be analyzed.  
 
Note: “0” is not a valid spacing.  If a “0” is entered in this field, the graph will not be drawn. 
 
Step Size 
 
The Step Size field contains the spacing increment to apply between each iteration.  

Series 
 
The Series section controls the vertical axis (or axes). Click the round option control next to the 
series titles to graph that series. 
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Luminance 
 
Values for average, minimum, and maximum luminance are plotted in blue. These will always be 
plotted against the left axis. Values for average/minimum and maximum/minimum luminance ratio 
are plotted in green.  The axis will appear on the right, or on the left if average, minimum, or 
maximum is not selected. 
 
CIE 2000 only:  A series for Longitudinal Uniformity (Ul) will also be available on the green axis. 
 
Illuminance 
 
The illuminance series behave in the same fashion as the luminance series, see above. 
 
Veiling Luminance Ratio [ Lv ] – IESNA RP8 Only 
 
The Veiling Luminance Ratio option only appears when the IESNA RP8-2000 calculation method 
is selected in Step 1. 
 
Small Target Visibility [ STV ] – IESNA RP8 Only 
 
The Small Target Visibility option only appears when the IESNA RP8-2000 calculation method is 
selected in Step 1. 
 
Threshold Increment [ Ti ] – CIE 2000 Only 
 
The Threshold Increment option only appears when the CIE 2000 calculation method is selected 
in Step 1. 

Reference Lines 
 
The Reference Lines section controls the display of reference lines.  Reference lines are drawn 
across the graph at particular threshold values, to aid in the evaluation of the lighting system. 
 
Design Criteria 
 
These lines will be drawn in magenta for each series that has a design criteria value specified on 
Step 4. 
 
IES/CIE Recommendations 
 
These lines will be drawn in red for each series that has an associated IES/CIE recommended 
value. 
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2.3 The Compare View 
 
The compare view provides a side-by-side comparison of the currently loaded designs.  Three 
designs are visible at a time -- if more designs are loaded, a horizontal scroll bar will appear at 
the bottom of the screen. 
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2.4 Design Information 
 
The Design Information screen is accessed by selecting Information… from the Design menu.  
The information entered on this screen will be printed in the design summary, see Chapter 3. 
 

 
 
Title 
 
Changes to the Title field will be reflected in the dropdown list on the main toolbar.   
 
Note: You can also change the title of a design by typing the new title directly into the list field on 
the main toolbar. 
 
Design Information Fields 
 
The remaining fields on the screen can be renamed as desired. Click on the field caption and 
enter a new value. In the example below, the “Name” field has been changed to “Designer”. 
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2.5  Selecting a Photometric File 
 
It will often be necessary to select a photometric file for use with a luminaire.  This is 
accomplished via the Photometric File Dialog.  Much of the operation of the Photometric File 
Dialog is similar to standard Windows file dialogs.  Additional functionality specific to photometric 
data has been added to aid in finding a specific luminaire. 

2.5.1 The Files Tab 
 

 
 
The dialog will by default list any files with an IES, LDT, CIB, TMS, or CB1 extension. Files with 
other extensions may be seen by either selecting "All Files" from the FILES OF TYPE: list; or by 
typing *.??? (where .??? is the desired extension) into the FILE NAME: field and pressing ENTER.  
Visual can read any photometric file that is formatted in accordance with the IESNA LM-63, 
EULUMDAT, or CIBSE-TM14 specifications. 
 
Each file in the selected directory that matches the desired file type is opened and its header is 
read. The header data is displayed underneath the corresponding Column Header. The file list 
may be sorted by clicking on any of the Column Headers. Clicking on the same Column Header 
reverses the order of the sorted list. Some photometric files may not contain certain header 
information, in which case the corresponding Column entry will be blank. This does not imply that 
the photometric file is invalid, only that there is no header data to display. 
 
Some photometric files may contain an infolink, which points to a web page containing 
information particular to that file.  If a file containing an infolink is selected from the file list, the 
Infolink button will be activated.  Clicking this button will launch the default web browser and 
direct it to the appropriate web page. 
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2.5.2 The Advanced Tab 
 
Column Headers may be turned on or off, repositioned, or customized by clicking on the 
Advanced tab in the bottom-left corner of the dialog. A list of Column Headers and their 
associated header data will be displayed. 
 

 
 
To turn a column on or off, check or uncheck the box next to the desired Column Header name. 
 
To reposition a column, click on the Column Header name to select it.  Then use the arrow 
buttons on the right of the dialog to move the column through the list.  The Name column header 
that corresponds to the filename can not be turned off or repositioned (it will always be the first 
column). 
 
To add a custom column, enter the name of the Column Header in the Description: field.  Then 
enter the header data to search for into the Data: field. It is important that this matches exactly 
with the header field in the photometric file.  Finally, click the Add button.  A new entry will be 
added to the column list. 
 
To delete a custom column, click the desired Column Header name to select it, then press the 
DELETE key.  Only column headers that have been added using the Add button may be deleted. 
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2.6 The Options Screen 
 
The Options screen is accessed by selecting Options… from the Tools menu. The Options 
Screen controls various display and program settings.  There are three buttons at the bottom of 
the Options screen:  Apply applies settings to the currently active design, Apply to All applies 
settings to all designs in the project, and Cancel exits the Options screen without applying any 
changes.  
 
Note: To save settings as the default for new roadway designs, select Save As Default from the 
File menu. 

2.6.1 Contours 
 

 
 
The contours options category controls the parameters for the iso-contour lines that are displayed 
on the roadway graphic. Click the button directly underneath a text field to activate or deactivate 
an iso-contour.  Clicking the arrow next to the activation button displays a color palette.  If an iso-
contour is active, the value in the text field may be modified. 
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2.6.2 Statistics 
 

 
 
The Statistics options category controls the display of the calculated metrics.  Items with a 
checkbox beside them can be added or removed from the Results Display and the printed output.  
Items without a checkbox control the calculation grids displayed on the Roadway Graphic. 
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2.6.3 Calculations 
 

 
 
The Calculations options section controls parameters used during calculations. Each subsection 
is described below. 
 
Grid Spacings 
 
Both the IESNA and CIE explicitly specify the spacing and location of the calculation grids used in 
compliant roadway lighting calculations.  The Roadway Lighting Tool will use the recommended 
parameters if the IES/CIE Recommendations checkbox is checked.   
 
Alternative calculation grid parameters may be specified by clearing the IES/CIE 
Recommendations checkbox and entering the desired values into the subsequent fields.  
 
For the following descriptions, a row of calculation points is defined to be a uniformly spaced line 
of points parallel to the direction of travel of the roadway. 
 
The Longitudinal Points per Cycle field specifies the minimum number of points that will be 
placed in each row of calculation points in the calculated luminaire cycle. 
 
The Maximum Longitudinal Spacing field specifies the maximum distance between 
consecutive points along a row of calculation points.  Note that this may result in more points 
being placed than are specified in the Longitudinal Points per Cycle field. 
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The Transverse Points per Lane field specifies the number of rows of calculation points that will 
be placed in each lane of the roadway.  The rows will be uniformly spaced and centered in each 
lane. 
 
Optimization Parameters 
 
The initial spacing used by the optimization routine is calculated by multiplying the average 
mounting height of all luminaires by the value in the Initial Spacing/Mounting Height Ratio field. 
Calculations may converge more quickly if the initial spacing is close to the final optimized 
spacing. 
 
Veiling Luminance Calculations 
 
The Extend luminaires back to the observer position checkbox allows the Roadway Lighting 
Tool to implement an upcoming modification to the IESNA RP-8 veiling luminance calculation. 
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Chapter 3 - Printing 
 
The Print screen is accessed by selecting Print… from the File menu or by clicking the Print 
button on the toolbar. Depending on which View (Steps, Graph or Compare) is active, different 
print options will be displayed.  The graphic below illustrates the options when printing from the 
Steps View. 
 

 
 
Printer 
 
The Printer section provides a drop-down list containing all the installed printers.  Clicking the 
Properties… button launches a printer properties window for the currently selected printer.  Note 
that the printer properties window is provided by the installed printer drivers, not by the Visual 
Roadway Tool. 
 
Design Information 
 
The Design Information Section is only available when printing from the Steps or Graph Views.  
Its behavior is exactly the same as that of the Design Information screen, described in Section 
2.4. 
 
Print Pages 
 
The Print Pages section will have various options depending on the current View.  Each of the 
printed pages is described in the following sections. 
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3.1 Design Summary 
 

 
 
The Design Summary is a one page summary consisting of design information, roadway 
geometry and classification, all applicable luminaire information and the calculated results. 
 
The Design summary may be printed from all three Views (Steps, Graph or Compare).  If it is 
selected in the Compare view, one summary page for each design will be printed. 
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3.2 Calculation Grid 
 

 
 
Each calculation grid used in the roadway calculations can be printed from the Steps View.  
Select the desired grid(s) on the Print Pages section of the Print screen. 
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3.3 Graph 
 

 
 
The graph page may be printed from either the Steps View or the Graph View. 
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3.4 Comparison 
 

 
 
The Comparison page can only be printed from the Compare View.  Up to six designs will be 
printed per page. 
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File Menu Commands 
Contents 
 
• NEW 
• OPEN 
• SAVE 
• SAVE AS… 
• SAVE AS DEFAULT 
• IMPORT… 
• PRINT…  
• EXIT 
 

New 
 

The New command begins a new Roadway Lighting Tool project.  All existing designs will be 
cleared and the Roadway Lighting Tool will be loaded with the default settings. Note that this 
is not the same as adding a new design to the current project (see the New command under 
the Design menu).  

 

Open 
 

The Open command loads an existing Roadway Lighting Tool project file (*.RWT) from a 
disk.  The current project will be replaced with the file contents.  See the Import command 
under the File Menu for additional options. 

 

Save 
 

The Save command saves the current Roadway Lighting Tool project to a disk file (*.RWT).  
If the project has an associated filename, the Save command saves directly to that file with 
no dialog.  If the current project does not have an associated filename (ie, has never been 
saved to a file), the Save command behaves in the same manner as the Save As… 
command. 
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Save As… 
 

The Save As… command displays the File Selection dialog so that a filename can be 
specified for the current Roadway Lighting Tool project.  Clicking the Save button on the File 
Selection Dialog saves the project to the specified disk file. 

 

Save As Default 
 

The Save As Default command saves the current Roadway Lighting Tool project as the 
default project.  The default project will be loaded each time a new Roadway Lighting Tool 
project is started. 

 

Import… 
 

The Import… command loads a saved Roadway Lighting Tool project file into the current 
project.  Each design in the saved project will be added to the current project.  This command 
is useful for performing comparisons between multiple saved Roadway Lighting Tool 
projects. 

 

Print… 
 

The Print… command displays the Print Screen.  See Chapter 3 - Printing for more 
information. 

 

Exit 
 

The Exit command closes the Roadway Lighting Tool.  A prompt to save changes will appear 
if the current project has been modified but not saved to disk. 



Visual User’s Guide  42 
 

Design Menu Commands 
Contents 
 
• NEW 
• COPY 
• DELETE 
• INFORMATION… 
 

New 
 

The New command adds a new roadway lighting design to the current project and makes it 
the active design.  The new design is created using the settings in the default project (see 
Save As Default in the File menu). 

 

Copy 
 

The Copy command creates a duplicate of the currently active design, adds it to the project 
and makes it the active design.  If the original design has a title, the new design title will be 
the original design title followed by “(copy)”. 

 

Delete 
 

The Delete command removes the currently active design from the project.  No prompt is 
given to save changes, and the command is irreversible.  If there is only one design in a 
project and the Delete command is selected, the design will be removed and a new default 
design will be added, so that there is always one design in the project. 

 

Information… 
 

The Information… command displays the Design Information Screen.  See Section 2.4 
Design Information for more information. 
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View Menu Commands 
Contents 
 
• STEPS 
• GRAPH  
• COMPARE 
 

Steps 
 

The Steps command switches the Roadway Lighting Tool to the Steps View.  See Section 
2.1 The Steps View for more information. 

 

Graph 
 

The Graph command switches the Roadway Lighting Tool to the Graph View.  See Section 
2.2 The Graph View for more information. 

 

Compare 
 

The Compare command switches the Roadway Lighting Tool to the Compare View.  See 
Section 2.3 The Compare View for more information. 
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Tools Commands 
Contents 
 
• OPTIONS… 
 

Options… 
 

The Options… command displays the Options Screen.  See Section 2.6 The Options 
Screen for more information. 
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Help Commands 
Contents 
 
• CONTENTS 
• VISUAL WEB SITE 
• TECHNICAL SUPPORT 
• DEACTIVATE 
• ABOUT ROADWAY 
 

Contents 
 

The Contents command displays the Help file for the Roadway Lighting Tool. 
 

Visual Web Site 
 

The Visual Web Site command displays the Visual website, 
www.VisualLightingSoftware.com, in the default web browser.  The Visual website provides 
support, FAQs, account information and much more. 

 

Technical Support 
 

The Technical Support command displays a web page providing information on obtaining 
technical support. 

 

Deactivate 
 

The Deactivate command initiates the Software Deactivation process. This command is only 
active if the Software Activation process has been completed.  Software Deactivation frees 
the current license number for use on another computer. 

 

About Roadway 
 

The About Roadway command displays a screen providing version and activation 
information. 

 

http://www.visuallightingsoftware.com/
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Glossary 
 
Discomfort Glare 
 
Glare that produces discomfort to the observer but that may not necessarily hinder visual 
performance. 
 
Footcandle 
 
A unit of illuminance equal to one lumen per square foot. 1 fc = 10.76 lux. 
 
Glare 
 
The sensation produced by a luminance within the visual field that is significantly greater than the 
luminance to which the eyes are adapted. Glare results in discomfort or loss of visibility. 
 
Illuminance 
 
Illuminance is the density of light incident on a surface due to the lighting system. 
 
Lighting Classification  
 
The CIE specifies lighting recommendations based on a lighting classification system that ranges 
from M1 to M5. These lighting classifications are dependent on the function of the roadway, 
density of traffic, traffic complexity, separation of traffic, and the existence of traffic lights. They 
also consider motorist, motor and pedal cyclists, and pedestrians.  
 

Classification Description 
 
 
 
 
 

M1 
M2 
M3 

High speed roads with separate carriageways, free of crossing at grade and with complete access 
control; motorways; express roads. 
 
Traffic density and complexity of road layout: 
 
High 
Medium 
Low 
 

 
 
 
 

M1 
M2 

High speed roads, dual carriageway roads. 
 
Traffic control and separation of different types of road user: 
 
Poor 
Good 
 

 
 
 
 

M2 
M3 

Important urban traffic routes, radial roads, distinct distributor roads. 
 
Traffic control and separation of different types of road users: 
 
Poor 
Good 
 

 
 
 
 
 

M4 
M5 

Connecting less important roads, local distributor roads, residential major access roads.  Roads 
which provide direct access to property and lead to connecting roads. 
 
Traffic control and separation of different types of road user: 
 
Poor 
Good 
 

Refer to CIE 115-1995 for further information. 
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Light Loss Factor [LLF] 
 
A multiplier used in lighting calculations to represent the effects to the lighting system after a 
period of time and under certain conditions. This factor can be a combination of dirt 
accumulation, lamp lumen deprecation, ballast factors, maintenance procedures and equipment 
variations. 
 
Longitudinal Uniformity [UL] 
 
Longitudinal uniformity is the ratio of the minimum to the maximum luminance along a line parallel 
to the length of the roadway. This calculation is performed with the observer positioned in line 
with the calculation points. The purpose of the longitudinal uniformity metric is to prevent a 
pronounced repetitive pattern of high and low luminances on the roadway. 
 
Luminance 
 
Luminance is the density of light leaving a surface in a particular direction. For roadway lighting 
calculations, luminance is the amount of light reflected from the pavement in the direction of the 
driver.   
 
Lux 
 
A unit of illuminance equal to one lumen per square meter. 1 lux = 0.093 fc. 
 
Pavement Reflectance 
 
Pavement reflectance characteristics for a roadway surface are specified using a classification 
system ranging from R1 to R4, as defined by the IESNA and CIE. The calculation of roadway 
luminance and small target visibility (STV) depends on the reflective properties of the roadway. 
 

Classification Surface Description 
R1 Concrete A mostly diffuse concrete surface. 
R2 Asphalt A combination diffuse and specular surface.  This is not commonly used in North 

America. 
R3 Asphalt A slightly specular surface. This is typical for most asphalt highways in North America. 
R4 Asphalt A mostly specular surface with a smooth texture. 

Refer to IESNA RP8-2000 for further information. 
 
Pedestrian Conflict Area 
 
Pedestrian conflict areas are based upon the level of pedestrian traffic. Three classifications of 
pedestrian activity are defined by the IESNA in RP8-2000. 
 

Classification Description 
Low Areas with a low volume of nightly pedestrian activity. This is typical of neighborhoods and other 

low residential developments. A volume of up to 10 pedestrians per hour. 
Medium Areas with higher level of nightly pedestrian activity. This is typical for office areas, apartments, 

shopping areas, industrial locations, and streets that support transit lines. A volume of 10 to 100 
pedestrians per hour. 

High Areas with a significant level of nightly pedestrian traffic on sidewalks and intersections. This is 
typical of commercial areas, theaters, sports complex, and transit terminals. A volume of over 100 
pedestrians per hour. 

Refer to IESNA RP8-2000 for further information. 
 
Roadway Classification 
 
Roadway Classifications are based on the level of vehicular traffic and intended function of the 
roadway. The roadway classifications are defined in the IESNA RP8-2000. 
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Classification Description 
Freeway A A divided major roadway with full control of access. A roadway with high traffic volumes and a 

greater visual complexity. This is typically a roadway in a major metropolitan area or near the 
center of a city. 

Freeway B All other divided roadways with full control of access. 
Expressway A divided major roadway for through traffic and partial access control at the intersection of major 

roadways. 
Major The section of the roadway that supports the through-traffic flow. These sections are referred to as 

the thoroughfares that connect primary traffic generation and roadways leaving the city. 
Collector Roadways that support the traffic between the major and local streets. These roadways are 

primarily used for traffic movements within residential, commercial and industrial areas. Collectors 
are not meant to handle long thoroughfare. 

Local These roadways are primarily used to support access to residential, commercial and industrial 
property. Local streets are a majority of the total roadway system, but only carry a small portion of 
the traffic. 

Refer to IESNA RP8-2000 for further information. 
 
Small Target Visibility [STV] 
 
Small Target Visibility provides an evaluation of the visibility of an array of targets on the 
roadway. This calculated value is based upon the luminance of the targets, the luminance of the 
background, the adaptation level of the adjacent environment and the disability glare. 
 
Threshold Increment [Ti] 
 
Threshold Increment is a measure of the loss of visibility due to disability glare from the 
luminaires of the roadway design. This value represents a percentage increase in the luminance 
difference required to make a target visible in the presence of glare compared to when the target 
is barely visible in the absence of glare. 
 
Veiling Luminance [Lv] 
 
Veiling luminance is the effect produced by bright sources or objects in the visual field that 
causes decreased visibility and visual performance. The veiling luminance calculation is 
performed with the observer looking in a downward direction of view of one degree as defined in 
IESNA RP8-2000. 
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